The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments GmbH.

Mac, Mac OS, GarageBand, Logic, iTunes and iPod are registered trademarks of Apple Inc., registered in the U.S. and other countries.
Windows, Windows Vista and DirectSound are registered trademarks of Microsoft Corporation in the United States and/or other countries.
All other trade marks are the property of their respective owners and use of them does not imply any affiliation with or endorsement by them.

Document authored by: Adam Hanley
Software version: 6.0.1 (11/2015)
# Table of Contents

## 1 Welcome to Diving Deeper

### 1.1 The REAKTOR 6 Documentation

### 1.2 Manual Conventions

## 2 Play Mode vs. Edit Mode

### 2.1 Play Mode

### 2.2 Edit Mode

## 3 Controlling REAKTOR with MIDI and OSC

### 3.1 Configuring OSC Settings

### 3.2 Making OSC Connections

#### 3.2.1 MIDI and OSC Learn

#### 3.2.2 Connection Manager

### 3.3 Connect Properties

#### 3.3.1 MIDI Properties

#### 3.3.2 OSC Properties

#### 3.3.3 Ensemble and Instrument Properties

## 4 Automation

### 4.1 Automation Properties

### 4.2 Common Issues

## 5 Snapshots and Presets

### 5.1 Snapshots for Multiple Instruments

### 5.2 Snapshot Master

#### 5.2.1 Changing the Snapshot Master

### 5.3 Storing and Editing Snapshots

### 5.4 Comparing Snapshots

### 5.5 Re-ordering Snapshots
### Table of Contents

5.6 Morph and Random ................................................................. 46
5.7 Snapshot Banks ........................................................................ 48
   5.7.1 Creating and Editing Snapshot Banks ................................ 50
5.8 Default Values ......................................................................... 51

6 The Player and Recorder ............................................................ 53
   6.1 The Player ............................................................................. 53
   6.2 The Recorder .......................................................................... 54
      6.2.1 Recording Audio .............................................................. 55
      6.2.2 Recorder Settings ............................................................ 56

7 The Preferences Window ............................................................. 58
   7.1 General Preferences .............................................................. 58
   7.2 CPU Usage Preferences ........................................................ 61
   7.3 Directories Preferences .......................................................... 62

8 The Sample Map Editor .............................................................. 68
   8.1 Sample Maps ......................................................................... 69
      8.1.1 Importing and Exporting Sample Maps .......................... 69
   8.2 The Sample List ....................................................................... 70
      8.2.1 Editing the Sample List ................................................. 72
   8.3 The Map View ......................................................................... 76
   8.4 Waveform View ....................................................................... 82
   8.5 Note Actions ........................................................................... 84
   8.6 Sample Map Editor Settings .................................................... 86
   8.7 External Editor ........................................................................ 87

9 Panel Layouts ............................................................................. 88

10 Panelsets .................................................................................. 92
   10.1 Recalling Panelsets ............................................................. 92
10.2 Creating and Editing Panelsets .............................................................. 96

11 **An Introduction to Building** .................................................................................. 99
11.1 Navigating the Structure View ............................................................................. 100
11.2 Navigation Tools ................................................................................................... 103
   11.2.1 Split Screen ................................................................................................. 103
   11.2.2 Breadcrumbs .................................................................................................. 107
   11.2.3 Bookmarks ................................................................................................... 107
11.3 Loading and Connecting Instruments .................................................................... 109
11.4 Learning More ........................................................................................................ 113

12 **Keyboard Shortcuts** .............................................................................................. 115

Index .................................................................................................................................. 119
Welcome to Diving Deeper into REAKTOR. This document picks up where the Getting Started left off, covering some of the more advanced techniques and options available when using REAKTOR. As such, it assumes you are familiar with the main areas of the user interface, the general audio and midi settings, and how to load and play Ensembles, including Snapshot handling and basic MIDI control. If this sounds unfamiliar to you, we recommend that you read the Getting Started document first.

This document is designed to show you how to get the most out of your REAKTOR instruments and effects. It covers subjects that you have already been introduced to, like Snapshots and MIDI connections, in more detail. It also introduces more complex concepts like controlling REAKTOR with OSC.

The last section in this document introduces you to the Structure View as a precursor to the REAKTOR 6 Building in Primary document.
1.1 The REAKTOR 6 Documentation

The documentation for REAKTOR 6 is divided into five separate documents, guiding you from loading and playing pre-built Ensembles to building your own Instruments.

- **REAKTOR 6 What Is New** is written for users who are already familiar with previous versions of REAKTOR and only describes the latest features in brief.

- **REAKTOR 6 Getting Started** is for new users. It is the only document needed for users who intend to use REAKTOR for loading and playing pre-built REAKTOR instruments and effects.

- **REAKTOR 6 Diving Deeper** expands on the concepts introduced in the Getting Started document. It provides more detail on subjects like Snapshots (REAKTOR's preset system), and introduces advanced topics like OSC control and combining multiple Instruments in one Ensemble.
• **REAKTOR 6 Building in Primary** shows you how to build your own Instruments in REAKTOR’s Primary level. It focuses on a series of tutorials that guide you through building your first synthesizers, effects, and sequencers.

• **REAKTOR 6 Building in Core** describes the Core level of REAKTOR with its low-level building features, which can be used for implementing custom DSP algorithms. It includes reference information about the Core Macro Library, an comprehensive collection of DSP building blocks.

With the exception of the What Is New document, each of the documents listed above builds on the knowledge of the previous documents. While it is not necessary to read all of every document, some of the more advanced documents, like Building in Primary, assume knowledge from the previous documents.

**REAKTOR Content Documentation**

REAKTOR comes with a comprehensive Factory Library, including many pre-built instruments and effects, as well as Blocks, a new modular synthesizer framework that brings the experience of patching an analog modular synthesizer to REAKTOR. The manuals for this content, as well as any REAKTOR-based KOMPLETE instruments or effects you have installed, can be accessed from the Browser in REAKTOR’s Side Pane.

To open the manuals for REAKTOR content:

1. Click on the Browser icon in the Side Pane to open the Browser.
2. Select the Player tab.

3. Double-click on the folder of the content you wish to view the manual for.
4. Select the Documentation subfolder. The manual shows up as a PDF file in the lower section of the Browser.

5. Double-click on the PDF file.

→ The manual will open in your standard PDF reader.
1.2 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual.

- Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to locations on your hard disk or other storage devices is printed in *italics*.

- Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is printed in blue. Whenever you see this formatting applied, you will find the same text appearing somewhere on the screen.

- Important names and concepts are printed in **bold**.

- References to keys on your computer’s keyboard you’ll find put in square brackets (e.g., “Press [Shift] + [Enter]”).

► Single instructions are introduced by this play button type arrow.

→ Results of actions are introduced by this smaller arrow.

An indented, gray paragraph contains additional, contextual information.

Furthermore, this manual uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing these notes let you see what kind of information is to be expected:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="speech bubble icon" /></td>
<td>The speech bubble icon indicates a useful tip that may often help you to solve a task more efficiently.</td>
</tr>
<tr>
<td><img src="image" alt="exclamation mark icon" /></td>
<td>The exclamation mark icon highlights important information that is essential for the given context.</td>
</tr>
<tr>
<td><img src="image" alt="red cross icon" /></td>
<td>The red cross icon warns you of serious issues and potential risks that require your full attention.</td>
</tr>
</tbody>
</table>
2 Play Mode vs. Edit Mode

REAKTOR has two modes of operation:

- **Play Mode**: Optimizes REAKTOR for using instruments and effects. Editing features are limited in favor of a more streamlined interface and faster loading times.

- **Edit Mode**: Displays all the controls available for building and editing Ensembles.

When you first launch REAKTOR in stand-alone, and every time you load it as a plug-in, it will start in Play Mode.

2.1 Play Mode

The main benefits of Play Mode are:

- **Streamlined interface to maximize the Ensemble Panel space**: In Play mode, all of the Structure navigation controls are hidden, presenting a more streamlined workspace for those who want to use instruments and effects built in REAKTOR, but do not intend to edit the Ensemble Structures.

- **Optimized loading times for Ensembles**: Play Mode is required to be active in order for REAKTOR to use the Compiled Core Cell Code Cache, and so can decrease loading times of larger Ensembles significantly. For more information on the Compiled Core Cell Code Cache please read REAKTOR 6 Building in Primary document.

- **Increased ease of use as a plug-in**: Play Mode also makes working with REAKTOR as a plug-in easier by disabling any control options that are not saved in a host chunk — that is to say, any options that require you to save the Ensemble file when you are using REAKTOR as a plug-in. This means you no longer need to worry about the auto-save functions and host recall for your projects.

- **Double-click knobs to set them to their default value**: In Edit Mode, double-clicking anything on the Ensemble Panel generally opens the Properties for that Module. Since editing a Module's Properties is not possible in Play Mode, double-clicking is redefined to reset knobs and faders to their default value. This makes it easy, for example, to reset an EQ to a clean setting.
2.2 Edit Mode

To activate Edit Mode, click on the **EDIT** button in the Toolbar.

Edit Mode makes it possible to alter the Structure of an Ensemble, and edit any other settings that are saved in the Ensemble file.

For example, recalling Panelsets is possible in both Edit Mode and Play Mode, but creating Panelsets is only possible in Edit Mode. The same is also true for Snapshots.

Some of the features described in this manual will require activating Edit Mode, so if you notice a feature described that you cannot see in your instance of REAKTOR, try activating Edit Mode.
3 Controlling REAKTOR with MIDI and OSC

REAKTOR can use two standards for sending and receiving control messages:

- **MIDI**: Musical Instrument Digital Interface - a standard communication protocol for musical instruments created in the early 80s that is still commonly used today. Virtually all keyboard controllers will use MIDI to communicate with your computer.

- **OSC**: Open Sound Control - a more modern protocol that offers faster data rates, higher resolutions, and a more flexible architecture when compared to MIDI. However, OSC is less common and requires a little more technical knowledge to set up.

> Setting up MIDI and the assigning MIDI controllers is covered in the REAKTOR 6 Getting Started Document. Therefore the following sections will mainly focus on the OSC protocol.
3.1 Configuring OSC Settings

To open the OSC Settings window, enter the File menu and select *OSC Settings*...
The OSC Settings Window

The OSC Settings uses tabs to navigate between the three different sections:

- **Receive**: Here you can set up communication from an OSC Device to REAKTOR.
- **Send**: Here you can set up communication from REAKTOR to other OSC Devices.
- **Sync**: This tab contains the OSC sync options.

► In order to use OSC in REAKTOR, check the **OSC Activate** check box in the top left corner of the OSC Settings window.
The OSC Receive Tab

The Receive tab contains three main areas:

At the top is the Receive on Port value display. This is where you can view or edit REAKTOR’s OSC input Port number. The Port number is important for use in setting up communication from your OSC device. REAKTOR only receives OSC messages via this Port, so the number has to match the Port number set on your OSC device.

► To change the Port number, double-click on the value displayed, and enter a new value.

Below this you will see a display of the Local IP Address currently accessed by REAKTOR. These addresses are not editable from REAKTOR, but are displayed for use when setting up your OSC device.

The large area at the bottom of the window is the Incoming OSC Monitor.
The Incoming OSC Monitor

This displays all of the incoming OSC messages received by REAKTOR, and is primarily used for checking your connection is working correctly.

► To clear the monitor contents, click on the Clear button at the bottom right of the monitor display.

OSC Send
This area is used for entering the details of your OSC device(s) to enable communication with REAKTOR.

To enter the OSC target’s information:

1. Click on the **New** button below the OSC Targets window. A new target will then appear in the window with default information.

2. Enter the relevant information into the fields by clicking on the field and typing the settings from your OSC device.

3. When all information is entered correctly, you can send a test message by clicking the **Test** button.

4. The test message will be sent out to all of the OSC targets in the list. If your OSC controller has an OSC input indicator or monitor, it should show activity when the test message is sent.

You can also automatically search for other OSC enabled instances of REAKTOR:

1. Click the **Scan** button. REAKTOR will send a 'ping' message and listen for a 'pong'.

   A list of devices that sent a 'pong' reply to REAKTOR will appear in the OSC Targets list.

2. Remove any targets that you do not wish to use by clicking on the target name in the list to select it, and then clicking the trashcan icon to remove them.
Note that Scan only scans between port ranges 10000 and 10015.

**OSC Sync**

The OSC Sync Tab

The **OSC Sync** tab contains options for how REAKTOR should use OSC Sync messages.

To change the OSC Sync setting:

1. Click on the dropdown menu.

2. Select the Sync setting you wish to use from the list:
   - *No Sync*: REAKTOR will not send, or respond to OSC Sync messages.
   - *Enable Sync as Master*: REAKTOR will send OSC Sync messages to any device connected in the OSC Send tab.
• *Enable Sync as Slave:* REAKTOR will slave to OSC Sync messages sent from any device connected in the OSC Receive tab.

If you enable OSC Sync, additional options will become available.

The first additional option is always the **Select Sync Type** menu.

![Select Sync Type Menu](image)

The Select Sync Type Menu

It contains two options: ##CORRECT? DOUBLE CHECK!##

• *Time Sync:* This option sends/receives transport messages (start/stop/continue) as well as tempo information. This can be thought of as song position sync.

• *Clock Sync:* This option sends/receives transport messages only. So in this case, the OSC messages can start and stop playback, but they do not ensure that the tempo of the OSC devices are in sync.

If you selected the Enable Sync as Master option, then another control becomes available: **Delay messages by (ms)**

![Delay messages by (ms) Parameter](image)

Delay messages by (ms) Parameter

Changing the value of this parameter will delay the OSC Sync messages so that they are sent a select number of milliseconds after REAKTOR has generated them.

### 3.2 Making OSC Connections

#### 3.2.1 MIDI and OSC Learn

The easiest way to make an OSC connection is via the MIDI & OSC Learn function.

1. Right-click the control on the interface to which you want to connect.
2. Select *MIDI & OSC Learn*.

3. Move the OSC controller you want to use.

→ The OSC controller will now be connected to the REAKTOR Ensemble control.

### 3.2.2 Connection Manager

The Connection Manager is located in the Side Pane. It allows you to manage the MIDI and OSC connections in the loaded Ensemble.

To view the Connection Manager, click on the Side Pane tab with the controller icon.

The Connection Manager has two tabs, one for *MIDI* and one for *OSC*. Even though they use the different protocols, both tabs work in a very similar way, although the MIDI tab has a few more options than the OSC tab.
The current connections appear at the top of the list (they will be identifiable by the information present in the Target column).

Recently received messages appear below the current connections (by default, this list will only be refreshed each time you open the tab).

For MIDI, controller messages will appear above note messages.

To view incoming messages in real-time, activate the Auto button below the list. Not only will this re-populate the list in real-time, but it will also highlight currently used messages.

To clear the unconnected controllers in the table, click on the Clean button below the list.
Creating and Deleting Connections

You can make MIDI and OSC connections from the Connection Manager by drag and drop:

1. Click on the arrow icon next to the OSC control you want to use.

2. While holding the mouse, drag the control over the interface parameter you want to control.

3. Once you are over the parameter, release the mouse.

→ A connection will be made between the OSC control and the REAKTOR Ensemble control.

You can also activate MIDI and OSC Learn from the Connection Manager:

1. Click on the MIDI port icon to activate MIDI and OSC Learn.

2. Click on the REAKTOR control to which you want to connect.

3. Move the MIDI or OSC controller you want to use.

→ A connection will be made between the MIDI/OSC control and the REAKTOR Ensemble control.

You can also use the Connection Manager to remove OSC connections:

1. Select the connection you want to remove by clicking on it in the list.
2. Click on the trashcan icon below the list or press the [delete] key on your keyboard.

→ The selected connection will be removed.

### 3.3 Connect Properties

Every item in REAKTOR that can be connected to MIDI or OSC will have a Connect tab in their Properties.

To access the Connect Properties:

1. Click on the EDIT button in the Toolbar to activate Edit Mode.

2. Right-click on the control you want to edit.

3. Select "<control name>" Properties.

4. The Properties for this control will open in the Side Pane.

5. Click on the Connect tab to view the Connect Properties.
The Connect Properties for a control contains a number of sections, but this document will only cover the MIDI and OSC related sections. The other sections will be covered in the REAKTOR 6 Building in Primary document available from the Help menu.

The MIDI and OSC sections of the Connect Properties

It is possible to set up MIDI and OSC connections both into and out of REAKTOR from the Connect Properties.
3.3.1  MIDI Properties

The MIDI sections feature the following controls:

- **MIDI**
  - **Type**: Select the MIDI message type that the control will listen for.
  - **Note/CC Number**: Select the MIDI Number (if MIDI Type is set to Controller) or MIDI Note (if the MIDI Type is set to Note or Poly Aftertouch)

- **MIDI IN**
  - **On**: Activates MIDI to control the selected object.
  - **Soft Takeover**: Activates smoothing between the MIDI input and the Panel control, so that values do not suddenly jump when a new MIDI message arrives.
  - **Incremental**: Some dials and rotary knobs can be turned continuously — they do not have fixed lowest and highest positions. Such MIDI controllers send increment messages rather than absolute MIDI controller values. If you are operating your Panel control with such a MIDI controller, activate this option.

- **MIDI OUT**
  - **On**: When active, the Panel control will send MIDI messages when you interact with it from the interface.
  - **Remote Thru**: Forwards the incoming MIDI messages directly to the output.

3.3.2  OSC Properties

OSC Messages use Address Patterns to identify different controls. These Address Patterns are written similarly to website locations or file locations: strings of text separated by /

For example, an Address Pattern could be `/Page1/Cutoff`

The Address Pattern is then followed by the control value.

OSC can also send arrays of values (i.e. several values in one packet) in a single Address Pattern.
OSC Receive

You can connect an OSC control to a REAKTOR control via the OSC RECEIVE section of the Connect Properties.

1. Click on the Add Source menu.
2. Select New…
3. A new OSC source will be added to the table above.
4. Enter the Address Pattern of the OSC control.
5. If the OSC control sends data as an array of values, enter an index value in the Index column, otherwise leave it at 0.
6. Alternatively, select from the *Recently Received* sub-menu to automatically enter the Address Pattern of a recently received OSC message.

→ The OSC control will be connected to the REAKTOR control.

► If the *Recently Received* sub-menu list is too cluttered, click on the *Clear Recent List* to clear the OSC control addresses shown in the sub-menu.

To delete an OSC connection:

1. Select the OSC connection you want to delete from the table.
2. Click on the trashcan icon below the table.

→ The OSC connection will be removed.
OSC Send

The OSC SEND Properties

The **OSC SEND** section works in a different manner when compared to the **OSC RECEIVE** section.

To make an OSC Send connection:

1. Select an OSC Device from the **Add Target** menu.

2. Enter a **Send Address Pattern**. By default this will be the Panel control's name, but you can change this by selecting the text and entering new text. Send Address Patterns should always begin with a `/`

→ The OSC send connection has been created.

It is a good idea to create both an OSC Receive and an OSC Send connection for a control. This enables bidirectional communication, so that moving the REAKTOR control will update the OSC control and vice versa, keeping both controls at the same value.
3.3.3 Ensemble and Instrument Properties

The Connect Properties for Instruments and Ensembles look different to those of Panel controls.

These Properties deal with more general settings for controlling the Ensemble or Instrument.
MIDI In Settings

There are a number of MIDI In settings, which control how the Ensemble/Instrument will react to incoming MIDI messages.

- **External**: If you have multiple MIDI devices connected to REAKTOR, you can select which device will control the Ensemble/Instrument.
  - Select *All* if you want the Ensemble to accept MIDI messages from all the MIDI devices.
  - Select *None* if you do not want the Ensemble to accept MIDI message from any device.

- **Channel**: Select which MIDI channel to connect to the Ensemble.

- **Internal**: MIDI messages can be passed from Instruments within REAKTOR. From this menu you can select an Instrument from which the current Instrument will receive MIDI messages. This is a useful option for connecting a sequencer Instrument (like *Spiral*) to a synthesizer or sampler.

- **Upper Limit**: Sets the upper keyboard limit. MIDI notes above this limit will be ignored.

- **Lower Limit**: Sets the lower keyboard limit. MIDI notes below this limit will be ignored.

- **Note Shift**: Incoming MIDI notes will be transposed by this amount.

- **Sustain Ctrl**: Selects which MIDI CC messages will be used to control sustain pedal behavior. The General MIDI standard for this is MIDI CC 64.

- **Sustain Ctrl Active**: Toggles the sustain pedal behavior on or off.

- **Hold Ctrl**: Selects which MIDI CC messages will be used to control hold pedal behavior. The General MIDI standard for this is MIDI CC 66.

- **Hold Ctrl Active**: Toggles the hold pedal behavior on or off.

- **Morph Ctrl**: Selects a MIDI CC to connect to the Snapshot Morph Slider (see section ↑5.6, *Morph and Random* for more information on this feature).

- **Morph Ctrl Active**: Toggles the MIDI control of the Snapshot Morph Slider on or off.

MIDI Out Settings

There are three options for an Ensemble's MIDI output:
• **External**: If you have multiple MIDI devices connected to REAKTOR, you can select to which device the Ensemble will send MIDI messages.
  ◦ Select *All* if you want the Ensemble to send MIDI messages to all of the MIDI devices.
  ◦ Select *None* if you do not want the Ensemble to send any MIDI messages.

• **Channel**: Select on which MIDI channel the Ensemble will send its MIDI messages.

• **Internal**: MIDI messages can be passed from Instruments within REAKTOR. From this menu you can select an Instrument to which the current Instrument will send MIDI messages. This is a useful option for connecting a sequencer Instrument (like *Spiral*) to a synthesizer or sampler.
4 Automation

Like other plug-ins, controls in REAKTOR Ensembles can be automated by a host sequencer. Instruments and effects from Native Instruments (like MONARK or THE FINGER) already have their automation settings set up to function correctly.

However, some Ensembles downloaded from other sources (including the REAKTOR User Library) might not be correctly set up, in which case you will need to fix the Automation IDs of the Ensemble.

If you are combining multiple Instruments in an Ensemble, you will also need to manage the automation settings.

Automation IDs

Every control in REAKTOR is given an Automation ID, which it compiles into a list to send to the host sequencer, telling it how many automatable parameters the REAKTOR plug-in contains.

Automation IDs are automatically generated, but are not always automatically updated.

- Removing controls will not update the automation list. If you add two controls to your Ensemble, and then delete the first one you added, a hole will be left in the automation list.

- Removing Instruments will update the Ensemble automation list. If you create an Ensemble with two Instruments, and delete the first one you added, the Automation IDs of the second Instrument will be moved up to fill the gap. Note that this behavior will not fill any gaps in the automation list of the Instrument.

In some cases, this should not be a problem, especially if you are using REAKTOR in stand-alone. However there are cases in which you will need to manage the Automation IDs, and this can be done from the Automation Properties.

4.1 Automation Properties

The settings related to automation can be found in the Properties for an Ensemble or Instrument, under the Connect tab in a section labelled AUTOMATION.
The following settings are available:

- **Show Name**: This checkbox selects whether or not the Instrument name will be included in the Automation Name of the control. Note that this option is not present in the Ensemble Automation Properties.
• **Base ID**: Displays the lowest Automation ID in use by the Instrument/Ensemble. This display can be used to show where an Instrument is positioned in the Ensemble's main Automation ID list.

• **Max ID**: This option selects the number of Automation IDs needed by the Instrument/Ensemble. Most of the time, this can be set to the same value as the Max ID in use display.

• **Max ID in use**: Displays the highest Automation ID of all the Modules inside the Instrument/Ensemble that can be automated.

• **ID Actions**: From this menu you can select several functions to perform on the Automation IDs in the Instrument/Ensemble:
  - *Compress IDs*: Select this option to compress the Automation ID list, effectively removing any gaps in the Automation ID list by changing the Automation IDs of the controls.
  - *Sort and Compress IDs*: Similar to the function above, but the controls are sorted in alphabetical order and given new Automation IDs accordingly.

### 4.2 Common Issues

If you are using REAKTOR Ensembles in a host sequencer and find that automation is not working as expected, there are often common causes that can be fixed quite easily.

**The Max ID Setting Is Not High Enough.**

If you are trying to automate a control and nothing is happening, try the following for each Instrument in the Ensemble and for the Ensemble itself:

1. Use the *Compress IDs* function to remove any gaps in the Automation ID list.
2. Increase the Max ID setting so that it is equal to the Max ID in use value.
If you find that automation for the control still does not work, then it is possible that automation has been blocked for that control by the builder of the Ensemble, which usually means that automating this control might cause problems.

The List of Automatable Controls in the Host Sequencer is Difficult to Read.

If you are trying to locate a control in the Automation ID list of your host sequencer, but find the Automation ID list difficult to read, try to following:

1. Use the *Sort and Compress IDs* function to arrange the Automation IDs in alphabetical order, and to remove any gaps in the Automation ID list.
2. Uncheck the *Show Name* option to remove excess text from the Automation Names.
5 Snapshots and Presets

Snapshots, which are REAKTOR's sound preset format, enable you to store and recall the settings of an Instrument's parameters.

The basics of storing and recalling Snapshots are covered in the REAKTOR 6 Getting Started document. This following section introduces you to more advanced Snapshot techniques and tools, available from the Snapshot tab in the Side Pane.

► Click on the camera icon to view the Snapshots tab in the Side Pane.

5.1 Snapshots for Multiple Instruments

Since an Ensemble can contain multiple Instruments, and Instruments can have their own Snapshots, there needs to be a way of selecting from which list of Snapshots is displayed in the Snapshot tab.

► Click on the menu at the top of the Snapshot tab to select an Instrument.

→ The Snapshots from the selected Instrument will be displayed in the Snapshot list.

The Ensemble can also have Snapshots, and so it also has an entry in this menu. The Ensemble entry is always located at the top and is marked with the prefix Ens - .

The Snapshot tab can also follow your Instrument selection automatically:

1. Open the Snapshot Edit menu, which is located to the top right of the Snapshot list.
2. Select the *Follow instrument selection* option.

With this option active, if you edit some parameters in an Instrument, that Instrument's Snapshots will be displayed in the Snapshot list, and the Snapshot list will always display the Snapshots of the last Instrument you interacted with via the mouse.

## 5.2 Snapshot Master

If an Ensemble contains multiple Instruments, Snapshots for all of the included Instruments can be recalled at once from the Snapshot Master.

Recalling a Snapshot from the Snapshot Master will recall the control values for all Instruments in the Ensemble and the Ensemble itself, including the selected Snapshots for each of the Instruments.

By default the Snapshot Master is the Ensemble.

The Snapshots of the Snapshot Master are the Snapshots that are used to populate the Snapshot menu in the Toolbar.
5.2.1 Changing the Snapshot Master

The Snapshot Master can be changed from the Ensemble to any of the Instruments inside it.

To change the Snapshot Master:

1. Select the Ensemble.
2. Open the Ensemble Properties.
3. Select the FUNCTION tab.
4. Find the section called SNAPSHOTS at the bottom of the Properties.

5. In this section, click on the Select Master menu.
6. Select the Instrument you wish to use as the Snapshot Master from this menu and click on it.

→ The selected Instrument is now the Snapshot Master for the Ensemble.

### 5.3 Storing and Editing Snapshots

Storing and editing snapshots can be done from the Snapshots tab in the Side Pane.

In order to store and edit Snapshots, you need to have REAKTOR in Edit Mode. See section ↑2.2, Edit Mode ↑2.2, Edit Mode for more information.

At the bottom of the Snapshot pane are three buttons for storing Snapshots.

- **Add**: Creates a new Snapshot at the end of the Snapshot list.
- **Store**: Overwrites the currently highlighted Snapshot.
- **Insert**: Creates a new Snapshot directly after the currently highlighted Snapshot, moving any other Snapshots down one slot in order to make space.

Snapshots are stored in the Ensemble, so you will need to save the Ensemble or Instrument in order to make changes to the Snapshots permanent.

If you want to delete a Snapshot, you can do this in two ways:
Select the Snapshot you wish to delete and press the [Delete] key on your keyboard.

Alternatively…

1. Select the Snapshot you wish to delete by clicking on it.
2. Click on the Edit menu at the top of the Snapshot tab.
3. Select Delete selected Snapshots.

You can select multiple Snapshots by holding the [Shift] key while clicking on the Snapshots.

You can rename a Snapshot by double-clicking on its current name and typing in a new name.

5.4 Comparing Snapshots

When using the Compare Snapshot feature, the modified Snapshot is stored in the “compare buffer”, and the Compare Snapshot menu entry is used to toggle between the original Snapshot and the modified version of that Snapshot.

To compare a Snapshot with a modified version of the same Snapshot, follow these instructions:
Snapshots and Presets
Comparing Snapshots

1. Make sure there is no checkmark in front of the Compare Snapshot menu entry in the Edit drop-down menu.

![Edit drop-down menu](image)

2. Select a Snapshot in the Snapshot list.
3. Modify the settings of the Instrument controls as desired.

→ Use the Compare Snapshot menu entry in the Edit drop-down menu to toggle between the original and modified Snapshot versions. If you want to make further modifications, repeat instruction steps 3-4.

To compare two different Snapshots in the Snapshot list of an Instrument, follow these instructions:

1. Select a Snapshot in the Snapshot list.
2. Next, select another Snapshot in the Snapshot list. The first Snapshot is now stored in the “compare buffer”.

→ Use the Compare Snapshot menu entry in the Edit drop-down menu to toggle between the two Snapshots.

If you are modifying a Snapshot and accidentally select a different Snapshot, you can recover your modifications by choosing the Compare Snapshot menu entry right away (before you make any changes to the new Snapshot).
5.5 Re-ordering Snapshots

You can re-arrange Snapshots in a Bank in a number of ways:

► Double-clicking on the Snapshot number and entering a new number will move the Snapshot to that location, and displace any Snapshots that may be in the way of that action.

► You can also use the Sort and Compress Snapshots option in the Edit menu to automatically re-order the Snapshots so that no empty slots are left between Snapshots.

Sorting Snapshots

You can also re-organize the Snapshots without permanently re-ordering them:
• Click on the # table header to sort the Snapshots by number.

• Click on # again to reverse the number sorting.

• Click on SNAPSHOTS table header to sort the Snapshots alphabetically by name.

• Click on SNAPSHOTS again to reverse the name sorting.

5.6 Morph and Random

REAKTOR gives you the ability to morph Snapshots, as well as randomize them.

The Morph and Random controls are hidden by default.

► To display the Snapshot Morph and Random controls, click on the Morph + Random arrow at the very bottom of the Snapshot pane.
Morphing Snapshots

The Snapshot morph feature allows you to blend the parameter values of two different Snapshots.

To use this feature, you must first select the two snapshots you want to blend.

1. The selected Snapshot will automatically be selected as the first Snapshot, you will see it in the box on the left.
2. To change this, simply select a new Snapshot as normal.
3. To select the second Snapshot, click on the box to the right of the Morph area (above the Rnd. Merge button). This will set the text in the box to Select …

4. While this text is displayed, select a Snapshot as normal.

   ► With the two Snapshots selected, blend between them by clicking and dragging on the blue slider.

Note that when you move the Morph slider past the 50% mark, selecting a new Snapshot will place that Snapshot in the right box.

Binary controls, like buttons and switches, will not blend with the Morph slider, because they can only ever be on or off with no states in between. Instead you select one of the Snapshots whose settings will be used for any binary controls in the instrument. By default this is the first Snapshot.

► Clicking on the buttons to the left and right of the morph slider will select which Snapshot will be used for button and switch settings.

The Morph slider has a blend time, which smoothes the movement of the slider.
To set the Morph time, click and drag vertically on the numeric value between the two Snapshot boxes. This will set the smoothing time in seconds.

You can also set the Morph time by double clicking on this value and entering a specific number (from 0 to 60)

Randomizing Snapshots

The bottom row in the Morph + Random area contains the Snapshot Randomization controls.

There are two buttons that randomize the parameter settings of the Instrument in different ways:

- **Randomize**: triggers the randomization of the values based on their current settings.
- **Rnd Merge**: randomizes each parameter by blending between the two Morphing Snapshots. Each parameter is blended by its own random amount, so this technique produces results not possible when doing a straight morph using the Morph slider.

You can set the amount of randomization by editing the value between these buttons, either by clicking and dragging vertically, or by double-clicking and entering a specific value (from 0 to 100).

5.7 Snapshot Banks

The upper half of the Snapshot tab is dedicated to the Snapshot Banks.
A Snapshot Bank can contain up to 128 Snapshots, and are a useful way to categorize your Snapshots.

Snapshot Banks appear as sub-menu categories in the Instrument Snapshot Menu, and in the Snapshot Menu in REAKTOR's Toolbar.
You can select a Bank by clicking on its name in the Snapshot tab.

The Snapshot table will display the names of the Snapshots in the selected tab.

This action will not load a Snapshot, so you can browse the contents of the Banks before loading a new Snapshot.

5.7.1 Creating and Editing Snapshot Banks

The options for creating and editing Snapshot Banks can all be found in the Edit menu at the top of the Snapshot tab.

The options available are:

- **New Bank**: creates a new empty Snapshot Bank and places it in the first available Snapshot Bank slot.
- **Save Bank**: opens a dialog window, which allows you to save the Snapshot Bank as an external file. You can use this function to export a Snapshot Bank when you want to share it.
- **Load Bank**: opens a dialog window, from where you can browse your file system for Snapshot Banks.

Loading a Snapshot Bank will overwrite the contents of the currently selected Snapshot Bank, so it is advised to create a new empty bank before loading a Snapshot Bank.
- **Clone Bank**: creates a duplicate of the selected Snapshot Bank, including duplicates of all the Snapshots contained within.

- **Init Bank**: initializes the Snapshot Bank, deleting all of its Snapshots.

- **Delete Bank**: removes the Snapshot Bank and deletes its contents.

You can also rename a Snapshot Bank by double-clicking on it, and then typing a new name.

5.8 Default Values

All parameters that can be stored in a Snapshot have a default value. Generally this is a neutral or middle setting. For example, an EQ gain slider would have a default setting of 0dB (no gain change).

When in Play Mode, you can set a control to its default value by double-clicking on it.

When in Edit Mode, double-clicking opens the control's Properties, so there is another way to set it to its default value:

1. Right-click ([ctrl] + click on OSX) on the control to open a menu.
2. Select **Set to Default** from the menu.

→ The control will now be set to its default value.

From the Snapshot Edit menu you have two options relating to the default values of the Instrument:
• *Set control values as default:* selecting this option sets all of the controls default values to their current settings.

• *Recall default values:* sets all of the controls in the instrument to their default setting.

If you accidentally select the Recall default values option, you can effectively undo this by using the Compare Snapshots feature.
6 The Player and Recorder

The Player and Recorder utilities allow you to play back and record audio files.

► Click on the tape icon in the Toolbar to open the Player and Recorder.

→ The Player and Recorder bar will open below the Toolbar, with the Player on the left and the Recorder on the right.

6.1 The Player

The File Player

The File Player enables you to route the Audio signal from an audio file (*.wav, *.aif, or *.aiff) into your REAKTOR Structure. The output of the File Player is sent directly to the first two Audio Inputs of the top-level Ensemble. This is particularly useful for testing when building an effect.

When the File Player is playing, all other signals that would otherwise arrive at the first two Audio Inputs are overridden in favor of the File Player's output signal.

If the Ensemble contains no audio inputs, then no sound will be heard when you use the File Player.

There are three ways to load an audio file into the Player:

• The first way is to double-click on any audio file in the Files tab of the Browser in the Side Pane. This action opens the Player/Recorder Bar (if not already open), loads the file into the Player and automatically starts the file playback.
• Alternatively, you can drag and drop audio files into the text field of the File Player (when first opened, this will say Select File). In addition to dragging and dropping from the Browser, you can fetch files from other places like from the Desktop of your operating system. Again, after you have performed this action the File Player automatically starts the file playback.

• The third way is to press the AUTO button of the File Player. This activates the Player's Auto Mode. A single click on any file audio file in the Browser results in the file being loaded and played back in the File Player.

The Player has three playback controls. They are (from left to right):
• Reset play position to zero. This control is only visible after a file has been played.
• Play/pause audio playback.
• Loop mode on/off.

► If you have a file loaded in the Player, you can use the anchor icon to drag and drop this file to another location. For example, you could drag the file into REAKTOR's Sample Map Editor.

► Click on the magnifying glass icon to the far right of the Player to open the Files tab of the Browser in the Side Pane.

6.2 The Recorder

The File Recorder enables you to record an Ensemble's audio output from its first two Audio Outputs. The recorded audio signal is written to an audio file on your disk.
Windows systems record *.wav files and OS X systems record *.aif files.

### 6.2.1 Recording Audio

To record a new audio file with the File Recorder:

1. Click on the Folder icon in the File Recorder.

2. Select a location, name, and format (wav or aiff) for the audio file in the dialog window.

3. Click Save to create the audio file.

4. Click on the Record Arm circle to activate record mode.

5. When you are ready to record, click on the Play button.

6. Click on the Stop button to stop recording.

   → The recorded audio will be saved in the audio file you created in steps 2 and 3.

If you do not specify a file name and location as directed in steps 1 to 3 above, then the audio file you record into will be located in the Audio Files sub-folder of the User Library location.

The recorded audio file will be a 16bit uncompressed wav or aiff file. The sample rate of the audio file will be the same as the sample rate REAKTOR was running at when the recording took place.

It is also possible to trigger the recording process via other means. These options are located in the Recorder Settings, which are described in the following section.
6.2.2   Recorder Settings

► You can access the Recorder’s settings by pressing the Recorder Settings button (the cog/gear icon).

→ The Recorder Settings dialog window will be displayed.

The Recorder Settings has 5 options available:

- **Record Start By**: This menu allows you to select a recording method (when the Recorder is armed). The options available are:
  - *Manual*: Recording can only be started by pressing the Recorder Start button.
  - *Clock Start*: Recording starts when the REAKTOR Clock is started with the Start Clock button in the Main Toolbar.
  - *Note On*: You can also start recording by a MIDI Note On event, i.e. when a key is pressed on your MIDI or computer keyboard.

- **Start Offset**: In this edit field you can specify a time delay in bars before the recording starts after a “record” event (specified in the Record Start By menu) has arrived.

- **Record Stop By**: This menu allows you to choose under which conditions the recording process is stopped:
- **Manual Only**: You can only stop the recording process using the Recorder Stop button.
- **Clock Stop**: Recording stops when the REAKTOR Clock is stopped with the Stop Clock button in the Main Toolbar.
- **Note Off**: You can also stop recording by a MIDI Note Off event, i.e. when a key is released on your MIDI or computer keyboard.
- **Loop Length**: The File Recorder stops recording when the loop length duration, as specified by the Loop Length edit field in bars, has been reached.

- **Loop Length**: This edit field lets you specify the duration of the recording in bars. This value is only used when the Loop Length option in the Record Stop By menu has been selected.

- **Slave Player Controls to Recorder**: With this checkbox you can cause the Player transport controls to follow those of the Recorder. This can be useful when you want to use the Player to send an audio file through a REAKTOR effect Instrument and simultaneously record the result at the output using the Recorder.
The Preferences Window contains options for some of REAKTOR's general functions and behavior. These are options that affect REAKTOR overall, but not the loaded Ensembles. Things like Library folder directories and color schemes are located here.

The Preferences Window can be accessed from the File Menu, by clicking on Preferences ..., or by using the keyboard shortcut [Ctrl]/[Cmd] + [,]

The Preferences Window has three tabs, which will be described in the following sections...

### 7.1 General Preferences

Click on the General tab to display the General Preferences.
The General Preferences

- **Create backup file before saving**: When this checkbox is engaged, REAKTOR will create a backup file of your Ensemble titled “Backup of <Ensemble name>” when you execute the Save Ensemble command. This backup is the version of the Ensemble as it was from the last save or load command.

- **On startup**: This menu determines which Ensemble, if any, REAKTOR will load when it starts up. There are three options:
  - *Load new ensemble*
  - *Load last ensemble*
  - *Don’t load anything*
• **Save workspace state with ensemble**: This option restores the Ensemble's GUI (graphical user interface) to the state it was when the Ensemble was last saved.

• **Globally disable event loops**: This prevents Event signal feedback loops from occurring in Ensembles.

• **Mute audio during core compilation**: When enabled, this option turns off all audio processing during the period of time that it takes to compile a Core Object. This makes compilation faster.

• **Number of undos**: This edit field allows you to set the maximum number of undos that can be performed in a row. Enter “0” to disable the undo function completely. More undos require more memory, but also provides more opportunities to correct mistakes.

• **Computer Keyboard MIDI Channel**: This drop-down menu specifies the MIDI channel for MIDI Notes played from the computer keyboard. This is set to 1 by default because REAKTOR Ensembles are set to receive MIDI messages on channel 1 by default.

• **Structure Theme**: This menu contains color scheme options for the Structure View. There are four options to choose from:
  - *Reaktor 6 Standard*: the default color scheme.
- **Reaktor 5**: the color scheme of REAKTOR 5.

![Image of Reaktor 5](image)

- **Dark Grey**: a darker variant of the Standard color scheme.

![Image of Dark Grey](image)

- **White**: a bright color scheme with white Modules and Macros.

![Image of White](image)

## 7.2 CPU Usage Preferences

- Click on the **CPU Usage** tab to view the CPU Usage Preferences.
The CPU Usage Preferences

The Max CPU usage (%) setting in this window is directly linked to the Automatic Voice Reduction feature, which is described in the REAKTOR 6 Building in Primary document.

Below the description of this feature is a section called System Info that displays technical information about your computer's CPU. This information may be useful to include if you ever need to contact technical support.

7.3 Directories Preferences

► Click on the Directories tab to view the Directories Preferences.
From the Directories Preferences you can set where on your computer's hard drive REAKTOR will search for files and folders in order to populate the Browser.

**Content Directories**

In the top half of this window there are three locations you can set for REAKTOR to search for REAKTOR content like Ensembles, Instruments, and Macros:
**Player - User**: Defines the path for content to populate the User sub-section of the Player tab in the Browser. This is a good location for any Ensembles you may have purchased or downloaded from a third party (like Twisted Tools or Heavyocity).
• **Library - Factory**: Defines the location of the Factory Library content (i.e. factory installed Macros and Instruments).

![Diagram of Library - Factory content organization](image-url)
• **Library - User**: Defines the location of content for the User sub-section of the **Library** tab in the Browser.

![](image)

► Click on the folder icon to change the location of any of these directories.

**External Sample Editor**

It is possible to launch an external sample editing program from the Sample Map Editor (see section ↑8, *The Sample Map Editor* ↑8, *The Sample Map Editor* for more information on launching an external sample editor).

You can define which program REAKTOR will launch as the external sample editor from this area.
Click on the folder icon to open a dialog window, and then select an application that can load wav and aiff files (for example, Audacity).

The selected program will launch whenever you open the external sample editor from the Sample Map Editor.

Compiled Core Cell Code Cache

When opening an Ensemble with large Core Cell structures in REAKTOR, a cache file of the compiled Core Cell code is saved on your hard drive. The next time you load the Ensemble, REAKTOR will access this cache file and skip the compiling stage, which significantly speeds up the loading process.

- The Compiled Core Cell Code is only used when REAKTOR is in Play Mode.
- Switching to Edit Mode when using Ensembles with large Core Cell structures causes a re-load of the Core Cells, which can cause REAKTOR to pause momentarily.

More information on the Compiled Core Cell Code Cache can be found in the REAKTOR 6 Building in Primary document available from the Help menu.

User Presets

This folder is the default directory for KOMPLETE KONTROL and MASCHINE user content. The path is not editable, but gives you the information required to add user content to the MASCHINE and KOMPLETE KONTROL Browser. After the folder is scanned by MASCHINE or KOMPLETE KONTROL, you can access the content from the user content area in the MASCHINE and KOMPLETE KONTROL Library Pane. More information about preparing Ensembles for KOMPLETE KONTROL and MASCHINE can be found in the Building in Primary document.
8 The Sample Map Editor

If the Ensemble you are working with includes any of the Sampler Modules, you will be able to access the Sample Map Editor.

When this is the case, a button with a waveform icon will appear on the right side of the Tool-bar, beside the Player/Recorder button and the Info Hints button.

The Sample Map Editor Button

► Clicking on this icon will open the Sample Map Editor.

The Sample Map Editor is where you manage and edit the samples used by the Ensemble.

For the purposes of illustration, this chapter will look at the Memory Drum 2 Ensemble, which is available from the REAKTOR Factory Library, in the Samplers folder. Memory Drum 2 is a good Ensemble to use if you want to learn how the Sample Map Editor works.

The Sample Map Editor is divided into two sections:
• On the left is the **Sample List**.

• The right side can switch between the **Map** (key mapping view) and the **Waveform** (sample waveform view).

## 8.1 Sample Maps

Sample Maps are a format REAKTOR uses to contain a list of audio samples along with their key mapping Properties.

Sample Maps can be exported and imported from the Sample Map Editor, allowing you save and share different collections of samples and their mappings. Samples can even be embedded in the Sample Map file.

Each Sampler Module in an Ensemble can hold one Sample Map, but an Ensemble can contain several Sampler Modules and thus an Ensemble can contain more than one Sample Map.

► You can select between the different Sample Maps in the Ensemble from the dropdown menu above the Sample List.

► When in Edit Mode, the Magnifying Glass button to the right of the Sample Map selector menu is used to locate the Sampler Module that uses the currently selected Sample Map in the Ensemble Structure.

### 8.1.1 Importing and Exporting Sample Maps

In order to import and export Sample Maps, you must activate Edit Mode.
To activate Edit Mode, click on the EDIT button in the Toolbar.

The Sample Map import and export options are accessed from the Sample Map menu above the Sample List.

Click on the Sample Map menu to display the Sample Map import and export options.

The Sample Map menu contains four options:

- **Import (Merge) ...**: Opens a dialog window from which you can locate and import a REAKTOR Sample Map file (a .map file). The imported Sample Map will be merged with the current Sample Map.

- **Import (Replace) ...**: The imported Sample Map will replace the previous Sample Map, and all audio data from the previous Sample Map will be deleted.

- **Export including Audio Data ...**: Opens a dialog window from which you can save the Sample Map as a .map file. The exported Sample Map will have all the necessary audio data embedded in the .map file.

- **Export with References Only ...**: This option is only available if all of the samples in the Sample Map are not embedded (i.e. their Embed option is unchecked). The exported Sample Map will act as a pointer to the external audio files.

### 8.2 The Sample List

The Sample List is a table view of the samples used in the selected Sample Map.

The Sample List will have a different appearance depending whether you are using Edit Mode or Play Mode:
• When using the Sample List with REAKTOR in Play Mode, only the Sample Name and the Sample Location will be visible in the list.

• Activating Edit Mode expands the number of columns in the list to include the key mapping parameters for each sample, and the embed state.
8.2.1 Editing the Sample List

Below the Sample List table are four buttons that can be used to perform quick edits to the Sample List:

- **Add**: Opens a dialog window for you to browse and load an audio sample file into the Sample List.

- **Replace**: Functions in a similar manner to the Add button, but the loaded audio sample will replace a selected sample in the Sample List. The newly loaded audio sample takes the key mapping settings of the sample it has replaced.

- **Save as**: Opens a dialog window for you to save a selected sample as an audio file.

- **Remove**: Deletes the selected sample from the Sample List.

These four options are also available from a menu that opens when you right-click on the Sample List.

![The Sample List Menu]

**Editing the Mapping**

In order to edit the mapping of the samples from the Sample List, you must activate Edit Mode.
To activate Edit Mode, click on the **EDIT** button in the Toolbar.

When looking at the Sample List with Edit Mode active, it is possible to view and edit the key mapping of the samples.

<table>
<thead>
<tr>
<th>Name</th>
<th>Root</th>
<th>L</th>
<th>H</th>
<th>L Vel</th>
<th>H Vel</th>
<th>Embed</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Dokument...</td>
<td>51</td>
<td>51</td>
<td>51</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Dokument...</td>
<td>52</td>
<td>52</td>
<td>52</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Dokument...</td>
<td>53</td>
<td>53</td>
<td>53</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Dokument...</td>
<td>54</td>
<td>54</td>
<td>54</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Dokument...</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>WAVEFILEZ...</td>
<td>56</td>
<td>56</td>
<td>56</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Dokument...</td>
<td>57</td>
<td>57</td>
<td>57</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>WAVEFILEZ...</td>
<td>58</td>
<td>58</td>
<td>58</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
<tr>
<td>_Document...</td>
<td>59</td>
<td>59</td>
<td>59</td>
<td>0</td>
<td>127</td>
<td></td>
<td>[ ]</td>
</tr>
</tbody>
</table>

The Sample List when viewed in Edit Mode

There are five columns in the Sample List that relate to the key mapping:

- **Root**: The root MIDI note of the sample, i.e. the note at which the sample will play back at its original pitch.
- **L (Low)**: The lowest MIDI note that will trigger the sample.
- **H (High)**: The highest MIDI note that will trigger the sample.
- **L Vel (Low Velocity)**: The lowest velocity that will trigger the sample.
- **H Vel (High Velocity)**: The highest velocity that will trigger the sample.

Each parameter listed above can be edited from the table:
1. Double-click on the value you want to edit.

2. Type in a new value (0-127).
3. Press [Enter] or click away to set a new value.

When editing the key mapping from the Sample List, you can view your changes in the Key mapping View for a graphical representation of the Sample Map, which may be easier to read.

**Referencing and Embedding Samples**

Samples can be embedded in the Sample Map (meaning that the audio file itself is saved in the Sample Map and thus also the Ensemble) or they can be referenced from an external location.

When you add a sample to the Sample List, it will be embedded by default. Embedding samples ensures that the audio files will always be available to the Ensemble, since they are saved inside it. However, this might not always be desirable as this will also increase the file size of the Ensemble. Keeping audio files as external files also means that they can be shared by other programs, so you could have a KONTAKT Instrument referencing the same audio files as a REAKTOR Ensemble.

To set a sample to not be embedded in the Sample Map:

1. Activate Edit Mode by clicking on the **EDIT** button in the Toolbar.
2. In the Sample List, locate the sample you wish to edit.
3. Click on the button in the **Embed** column of the Sample List.
4. A dialog window will open, asking you to save a copy of the audio file.
5. Browse to the folder where you want to save the file and click **Save**.

The Ensemble will now reference the sample from the location specified when you saved the audio file.
Referencing samples as external files can be risky. Moving or deleting the audio file may cause REAKTOR to be unable to load the sample next time you open the Ensemble.

► If you wish to embed the sample again later, you can do this by clicking on the Embed button again.

**The Sample Location**

When you add a sample to the Sample List, the location of the file will be displayed in the Location column.

If the Ensemble you are working on is intended for public release, you may want to hide this information.

To hide the audio file location:

1. Select the sample you want to edit, or hold [Shift] to select multiple samples to edit at once.
2. Right-click on the selected sample(s) in the Sample List.
3. Select the **Clear Location** option from the menu.

→ The information in the Location column of sample will change from the original audio file location to [Ensemble].
Clearing the sample location is only possible if the sample is embedded in the Sample Map.

**Additional Options**

The additional options in the right-click menu are only available if the selected sample is not embedded.

These options are:

- **Reload**: Reloads the audio file from the hard disk to refresh the sample held in REAKTOR’s memory. You may want to use this function if you have edited the audio file in an external audio editor.

- **Show in Folder**: Opens a file explorer window in your operating system at the location of the selected sample.

- **External Edit**: Opens the selected audio file in an external audio editing program. The external editor is set in the Directories tab of the Preferences Window, which is described in section 7.3, Directories Preferences.

### 8.3 The Map View

The Map View (key mapping) is located on the right side of the Sample Map Editor.
If it is not currently displayed, click on the Map tab to display the Map View.

The Map View displays a map of the samples according to their key and velocity ranges (the Map). The key range is mapped along the x axis, and the velocity range is mapped along the y axis. A sample can be set as a 2-dimensional zone in this map.

Above the Map is a display of information about the selected sample including (from left to right):

- The sample name.
- The sample rate.
- The length of the sample.

To the left of the sample name display is a play button.

Click on the play button to audition the sample.
**Editing the Map (key mapping)**

It is possible to edit the mapping parameters for a sample in the Sample Map by altering the size of the sample's zone in the Map.

- Select a sample for editing by clicking on its zone in the Map. A selected sample zone will be highlighted in blue.

- Click and drag a selection box over the zones to select a group of samples for editing.

- Click and drag from the edge of the zone to alter the zone's height (velocity range) and width (key range).
Click and Drag on the blue note on the virtual keyboard to change a sample's root note.

Move the whole zone to change all of these parameters at once.

The mapping parameters can also be edited via the values below the Map, either by clicking and dragging on them, or by double-clicking on them and entering a new value.

Adding and Removing Samples

To add samples to the Map, you can drag and drop them from a file browser into the main Map area.

Where you drag the samples will specify their mapping parameters:
• Drag to the top of the Map to map the samples to all keys and velocities, with a root note of middle C (MIDI note 60).

• Drag to a single key to set all the mapping parameters to that key.
• Drag several samples to a single key to map them to that key. This will distribute them evenly between different velocity ranges.

• Drag to any location in between to map the sample(s) with varying key-range distances. The key-range will depend on the location of the mouse in the Map.

To delete samples from the Map view:

► Select the sample(s) you want to remove and press the [Delete] key on your keyboard.
Select the sample(s) you want to remove, right-click in the Map area, and select *Remove* from the menu.

8.4 **Waveform View**

The Waveform view is located on the right side of the Sample Map Editor.

If it is not currently displayed, click on the *Waveform* tab to display the Sample Waveform View.
The Waveform view shows the waveform of the selected sample and contains a handful of controls related to the playback of the sample.

Above the main waveform is a display of information about the selected sample including (from left to right):

- The sample name.
- The sample rate of the sample.
- The length of the sample.

To the left of the sample name display is a play button.  
▶ Click on the play button to audition the sample.  

Below the waveform are a series of controls:

- **Reverse**: Toggles reverse playback of the sample.
- **Loop**: Toggle looping of the sample playback on or off.
- **Start**: Sets the loop start point.
- **End**: Sets the loop end point.
- **Alternate**: Activates alternating loop mode, in which the playback will alternate between forwards and reverse modes while looping.
- **Release**: Checking this option makes the loop continue even after releasing the note.
- **Phase Align**: This option is only available if the Sample Map is used in one of the Grain Sampler Modules. It applies signal analysis to align the phases of the grains. This can improve the sound quality, but requires more CPU resources.

**Editing Loop Points**

You can edit the **Start** and **End** positions of a loop from the controls below the waveform. However, it is also possible to set the loop points on the waveform itself.
Click and drag on the left side of the blue box to set the loop start point.

Click and drag on the right side of the box to set the loop end point.

### 8.5 Note Actions

Note actions are a way of automatically mapping one or more samples. They can be used to speed up the sample mapping process.
• In the Sample List, the Note Actions are located in the right-click-menu, under the Note Actions sub-menu.

• In the Map view, the Note Actions are located in the main right-click menu.

There are two note actions:

• **Set Root Note to Low Note**: Click on this option to set the root note value to the low note value for all selected samples.

• **Remap to Single Notes**: Selecting this option remaps the samples so that each sample is on a single key. The keys are selected in such a way that the samples are mapped chromatically (on consecutive keys). Clicking on this option remaps all samples, regardless of how many you currently have selected. With a single sample selected, the root note of that sample will be used as the note from which the mapping will begin (in other words, it will be set as the lowest mapped key).
8.6 Sample Map Editor Settings

► Click on the cog icon in the top right corner of the Sample Map Editor to open The Sample Map Editor Settings menu.

The Sample Map Editor Settings menu contains five options that can be activated or deactivated by clicking on their entry.

The first three options all relate to the mapping behavior:

- **Move Root with Low Note**: With this option selected, changing the low note of the sample key range via the numeric editors will automatically match the root note to the same value. This option does not affect the behavior of the Map area.

- **Ignore Root Note on File Load**: Certain audio files can have root note meta-data. REAKTOR can read this meta-data to map the root note of the sample automatically, but with this option selected, REAKTOR will ignore this meta-data.

- **Single Note Mode**: With this option selected, changing the low note (L) in the Sample List will also automatically update the Root note and the high note (H) to the same value.

The next two options control aspects of how the Sample Map Editor behaves when selecting Samples:

- **Auto Prelisten**: With this option selected, clicking on a sample in the Sample List or the Map will trigger playback of the sample.

- **Select by MIDI**: When active, playing a MIDI note will automatically select the sample mapped to that note. If multiple samples are mapped to a single note, the sample that was most recently added to the Sample Map will be selected.
Having both of these options selected at once can cause a double-triggering of the sample when playing the MIDI keyboard.

8.7 External Editor

If you are mapping samples in REAKTOR and realize that one or more of the audio files need edited in another program, you can open the samples in that program from inside REAKTOR.

The application that REAKTOR opens can be defined in the Directories tab of the Preferences (see section 7.3, Directories Preferences for more information).

To the left of the Sample Map Editor Settings menu is a button that opens an external sample editor.

► Click on the wrench icon to open the external sample editor.

The external editor can only be opened if the selected sample is not embedded in the Sample Map.
9 Panel Layouts

If you are using an Ensemble that contains more than one Instrument, you can move these Instruments around into a setup that suits you.

The REAKTOR 6 Getting Started document covers the A/B Views of an Instrument, but this section will look into altering the Panel View further.

For the purposes of illustration, this document will use the Akkord Ensemble from the Factory Library, as it uses two Instruments (one for the sequencer, and one for the Synthesizer).

1. To edit Panel Layouts, you must use REAKTOR in Edit Mode. To activate Edit More, click on the EDIT button in the Toolbar.
2. Load the Akkord Ensemble from the Factory Library; it is located in the Sequenced Synthesizers section.
3. Click on the Header of the Lower Instrument (the synthesizer).

4. Drag it over the sequencer Instrument.
5. Release the synthesizer and it will be placed above the sequencer.

Notice that as you drag and drop the Instruments, they lock into place. This behavior is called **Automatic Layout**, and can be deactivated.

1. To deactivate Automatic Layout, right-click on an empty space in the Panel View.
2. Uncheck the *Automatic Layout* option from the menu by clicking on it.

3. This option is also found in the *Settings* menu as *Automatic Panel Layout*.

→ With this option unchecked, when you move an Instrument, it will remain wherever you drop it and will no longer lock into place.
10 Panelsets

Panelsets are a way of saving and recalling REAKTOR Panel Layouts. They are especially useful when an Ensemble includes more than one Instrument, as they can be used to quickly cycle between different panel configurations of the Instruments.

Panelsets can be viewed and edited from the Side Pane.

► To view the Panelsets, click on the Panelset tab in the Side Pane.

10.1 Recalling Panelsets

An Ensemble in the REAKTOR Factory Library that makes good use of the Panelsets is *Vectory*, so it will be used to illustrate how to recall Panelsets.

► Load *Vectory* from the Grooveboxes section of the Reaktor Factory Library.
The Vectory Ensemble

*Vectory* manipulates samples to produce its sound, but when you first load the Ensemble, it appears as if there is no way to load samples into the Ensemble from the interface. However, looking at the Panelsets, you will see that Vectory has two Panelsets: *Mashup* and *Setup*. 
The initial view that loads with the Ensemble is the Mashup Panelset.

► Click on the **Setup** entry in the Side Pane to load the Setup Panelset.
The Panel changes to display different Instruments: a Sample Loader and a MIDI Controller Setup Instrument.
You can also recall Panelsets from the Settings menu, by clicking on the relative entry in the Recall Panelset sub-menu.

10.2 Creating and Editing Panelsets

In order to create or edit Panelsets, you need to have REAKTOR in Edit Mode.

To activate Edit Mode, click on the EDIT button in the Toolbar.

In Edit Mode, there are three additional buttons below the Panelset list:

- **New**: Creates a new Panelset that stores the current Panel configuration.
- **Store**: Overwrites the selected Panelset with the current Panel configuration.
- **Remove**: Deletes the selected Panelset.
Below the Panelset buttons you will see a list of the Instruments in the loaded Ensemble.

To edit and store a Panelset:

1. Show and hide Instruments by clicking on the buttons beside their name.

2. You can then arrange the Instruments on the Panel.

3. When you are finished, save the Panelset clicking on the New button.

4. Rename the new Panelset by double-clicking on its name and typing a new name.

5. Press [Enter] or click away to set the new name.

→ The newly created Panelset will be available for recall.
Remember to save the Ensemble file to make these changes permanent.

**What is Stored in a Panelset**

Panelsets store the following information:

- The visibility of each Instrument in the Ensemble.
- The Header visibility of each Instrument and the Ensemble.
- The A/B view selection and minimized/maximized state of the Instruments.
- The positions of the Instruments on the Panel.
- The Snap to Grid and Automatic Layout Panel settings.
11 An Introduction to Building

The following sections will introduce you to the Structure View, giving you grounding in the skills needed to start building in REAKTOR.

If you are interested in learning to build instruments and effects in REAKTOR, it is suggested that you read these sections and then move on to the REAKTOR 6 Building in Primary document available from the Help menu.

All of the following sections require REAKTOR to be in Edit Mode.

Building in REAKTOR is done in the Structure View.

In the Structure View you can view the building blocks of a REAKTOR Ensemble (called Macros, Modules, and Core Cells). These building blocks are connected by wires.

REAKTOR's programming environment is analogous to a signal flow diagram, in which the blocks represent functions and the wires represent signals going into or coming out of these functions.

In simple terms, REAKTOR works a little like a modular system, or a rack. You can create an oscillator, which you then connect to a filter via a wire. A keyboard can be connected to the oscillator via another wire, and so on.
11.1 Navigating the Structure View

Navigating a structure in REAKTOR is almost always accomplished by double-clicking.

1. Load an Ensemble (for the purposes of illustration, this document will show the Junatik Ensemble from the Factory Library)
2. Double-click on a blank space in the Panel View.

→ The first level of the Ensemble Structure will be displayed in the Structure View.

In the first level of the Ensemble Structure you will see Instruments as blocks. These Instruments contain deeper levels of the Structure.

Instruments can usually be identified by the keyboard icon.

► Double-click on an Instrument to view its Structure.
In the next level down you will see more blocks, with wires running between them. These are **Macros** and **Modules**.

- **Modules** are the lowest level in REAKTOR Primary Structures, they cannot be edited and thus you cannot enter them.
- **Macros** are containers that can hold any number of Modules and other Macros. The contents of a Macro can be edited.

Macros are usually identified by their cube icon.

In some cases this cube can be replaced by another icon, though that doesn't occur in the Factory Library.

- Double-click on the Macro to enter its Structure.

Alternatively, you can enter Macro structures using the right-click menu:

1. Right-click on a Macro to open the menu.
2. Click on the *Structure* option.

   → The Structure of the Macro will be displayed in the Structure View.

   You can continue to navigate deeper and deeper in the Structure View using these methods until you reach a Macro that contains only Modules.

   ► To return one level higher, double-click on an empty space in the structure.

   ► There are also some shortcuts to enter specific places in the Ensemble Structure.

   1. Return to the Panel View of the Ensemble.
2. Right-click on a knob to open the menu.

![Knob Menu]

The menu contains the following entries that relate to navigation:

- **Show in Structure**: Opens the Structure View at the level in which the Knob Module can be found. The Knob Module will be highlighted.

- **Show in Structure in Other Pane**: Functions like **Show in Structure**; only this option activates the Screen Split and opens the Structure View in the Other Pane, allowing you to view the Panel and the Structure at the same time.

### 11.2 Navigation Tools

#### 11.2.1 Split Screen

Having read the previous section, you have already been introduced to the Split Screen.

The Split Screen allows you to see two parts of the Ensemble Structure at the same time by dividing the screen into two panes.

▶ Activate Split Screen by clicking on either of the rectangle icons to the top right of the Structure View.
• The left icon splits the screen horizontally.

• The right icon splits the screen vertically.
When Split Screen is active, you can swap the contents of the Panes, alter the split point, and close the Split Screen:

► Click on the arrow icon to swap the Panes.

► Click and drag the central column to alter the split point.

► Click on the X to the top right of a Pane to close that Pane and thus close the Split Screen.

These Split Screen options can also be found in the View menu.

You can also open the Split Screen, or navigate between the Panes, by using the right-click menus:

1. Right-click on a Macro or Instrument.
2. Select *Structure in other Pane.*

→ The Structure of the Macro or Instrument will be displayed in the other Pane.

Inside a Macro, you can also navigate upwards in this way:

1. In a Macro Structure, right-click on an empty space.
2. Select *Parent in Other Pane.*
The Structure of the level above the current Macro Structure will be displayed in the other Pane.

11.2.2 Breadcrumbs

Breadcrumbs give you a map to your current location in the Structure. They show you the names of all of the Instruments and Macros you have entered to get to your current location. Breadcrumbs are located in the bar above the structure view.

Breadcrumbs

Your current location will be underlined.

► Click on a Breadcrumb to jump to that location in the Structure.

11.2.3 Bookmarks

Bookmarks allow you to save your current location to recall later. If you find yourself navigating back and forth between the same locations in the Structure, Bookmarks can make this process a lot easier.

Bookmarks also save the Split Screen settings, so they can be used to save and recall workspace setups.

Bookmarks are located above the Breadcrumbs.

► Click on a Bookmark to recall its location settings.
Click on the star icon to create a new Bookmark of your current location settings.

A new Bookmark will appear in the Bookmark bar.

Right-click on a Bookmark to edit it.

The Bookmark menu contains three options:

- **Rename**: Selecting this option will open a text box, into which you can enter a new name for the Bookmark.

- **Overwrite**: Saves the current location settings in the selected Bookmark.

- **Delete**: Removes the selected Bookmark.

Bookmark options can also be found in the View menu in the Bookmarks sub-menu.
The options available mostly mirror those available in the Bookmark bar:

- **Append**: Creates a new Bookmark, like clicking on the star icon.
- **Recall**: Opens a sub-menu from which you can select a Bookmark to recall.
- **Overwrite**: Opens a sub-menu from which you can select a Bookmark to overwrite with the current location.
- **Next Bookmark**: Recalls the Bookmark after the last Bookmark you recalled.
- **Previous Bookmark**: Recalls the Bookmark in the list before the last Bookmark you recalled.
- **Back**: Returns to your previous location settings.

### 11.3 Loading and Connecting Instruments

An Ensemble can be made up of multiple Instruments, which can be connected together or just run side by side in a single instance of REAKTOR.

In the following section you will learn how to load and connect Instruments in an Ensemble.

1. Load a Synthesizer Ensemble. For the purposes of illustration, this document will use *Carbon 2* from the Factory Library.
2. Enter the Ensemble Structure by double-clicking on an empty space outside the Instrument Panel.

3. Open the Library Browser in the Side Pane by clicking on the Library tab.

4. Open the Primary folder to view its contents.

5. Select the 06 - Studio Effects folder.

6. Drag and Drop one of the ism (Instrument) files from the lower half of the Browser into the Structure.
The selected effect Instrument will appear as an object in the structure.

The Ensemble now contains two Instruments, one synthesizer and one effect. The next step will be to connect them.

1. Move the Instrument you just loaded by clicking on it and dragging it to where you want it.

2. To connect two ports, click on one port and drag a wire to the port you want to connect it to.

3. Inputs are located on the left side of any object in the structure, and outputs are on the right side. Connect the L and R output ports of the synthesizer to the L and R input ports of the effect.
4. Connect the output ports of the effect to the main output Modules of the Ensemble (the two objects labelled Out on the right side of the Structure).

→ The structure should now look something like this.

When you return to the Panel View, you will see the effect you loaded below the synthesizer.
You can also import Ensembles as Instruments by dragging them from the Browser into the Structure.

### 11.4 Learning More

If you are interested in learning more about building in REAKTOR read the REAKTOR 6 Building in Primary document available from the Help menu. It contains tutorials for creating instruments and effects that teach the fundamentals of building, as well as guides to the advanced features of REAKTOR.
After working through that document, and if you are interested in diving deeper into building, you can move on to the REAKTOR 6 Building in Core document. The Core level of REAKTOR is a programming environment for building your own algorithms.
## 12 Keyboard Shortcuts

### Views

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser</td>
<td>[F1]</td>
<td>[F1]</td>
</tr>
<tr>
<td>Snapshots</td>
<td>[F2]</td>
<td>[F2]</td>
</tr>
<tr>
<td>Connection Manager</td>
<td>[F3]</td>
<td>[F3]</td>
</tr>
<tr>
<td>Panelsets</td>
<td>[F4]</td>
<td>[F4]</td>
</tr>
<tr>
<td>Properties</td>
<td>[F5]</td>
<td>[F5]</td>
</tr>
<tr>
<td>Sample Map Editor</td>
<td>[F6]</td>
<td>[F6]</td>
</tr>
<tr>
<td>Player and Recorder</td>
<td>[F7]</td>
<td>[F7]</td>
</tr>
<tr>
<td>Preferences</td>
<td>[Cmd] + [,]</td>
<td>[Ctrl] + [,]</td>
</tr>
<tr>
<td>Audio &amp; MIDI Settings</td>
<td>[Cmd] + [,]</td>
<td>[Ctrl] + [,]</td>
</tr>
<tr>
<td>OSC Settings</td>
<td>[Cmd] + [Alt] + [,]</td>
<td>[Ctrl] + [Alt] + [,]</td>
</tr>
<tr>
<td>Hide/show Horizontal Split</td>
<td>[F10]</td>
<td>[F10]</td>
</tr>
<tr>
<td>Hide/show Vertical Split</td>
<td>[F11]</td>
<td>[F11]</td>
</tr>
<tr>
<td>Full Screen</td>
<td>[F12]</td>
<td>[F12]</td>
</tr>
</tbody>
</table>

### General

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run/Stop Audio Engine</td>
<td>[Cmd] + [R]</td>
<td>[Ctrl] + [R]</td>
</tr>
<tr>
<td>MIDI/OSC Learn</td>
<td>[Cmd] + [M]</td>
<td>[Ctrl] + [M]</td>
</tr>
<tr>
<td>Start/Stop Clock</td>
<td>[Space]</td>
<td>[Space]</td>
</tr>
<tr>
<td>Reset Clock</td>
<td>[Alt] + [Space]</td>
<td>[Ctrl] + [Space]</td>
</tr>
<tr>
<td>New Ensemble</td>
<td>[Cmd] + [N]</td>
<td>[Ctrl] + [N]</td>
</tr>
<tr>
<td>Open Ensemble</td>
<td>[Cmd] + [O]</td>
<td>[Ctrl] + [O]</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

#### Save Ensemble
- **Shortcut (Mac OSX):** [Cmd] + [S]
- **Shortcut (Windows):** [Ctrl] + [S]

#### Save Ensemble As
- **Shortcut (Mac OSX):** [Cmd] + [Shift] + [S]
- **Shortcut (Windows):** [Ctrl] + [Shift] + [S]

#### Quit
- **Shortcut (Mac OSX):** [Cmd] + [Q]
- **Shortcut (Windows):** [Alt] + [F4]

---

#### Snapshots

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>[Down Arrow]</td>
<td>[Down Arrow]</td>
</tr>
<tr>
<td>Previous</td>
<td>[Up Arrow]</td>
<td>[Up Arrow]</td>
</tr>
<tr>
<td>Jump Forward 10 Snapshots</td>
<td>[Page Down]</td>
<td>[Page Down]</td>
</tr>
<tr>
<td>Jump Back 10 Snapshots</td>
<td>[Page Up]</td>
<td>[Page Up]</td>
</tr>
</tbody>
</table>

---

#### Bookmarks

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New</td>
<td>[Alt] + [´]</td>
<td>[Alt] + [´]</td>
</tr>
<tr>
<td>Recall 1…8</td>
<td>[Alt] + [1]…[8]</td>
<td>[Alt] + [1]…[8]</td>
</tr>
<tr>
<td>Overwrite 1…8</td>
<td>[Alt] + [1]…[8]</td>
<td>[Alt] + [1]…[8]</td>
</tr>
</tbody>
</table>

> The [´] key is system specific for English keyboards. The Create New Bookmark shortcut uses [Alt] + the key to the left of 1.

---

#### Help/Debug

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info Hints</td>
<td>[Alt] + [I]</td>
<td>[Alt] + [I]</td>
</tr>
<tr>
<td>Measure CPU Usage</td>
<td>[Alt] + [C]</td>
<td>[Alt] + [C]</td>
</tr>
<tr>
<td>Show Module Sorting</td>
<td>[Alt] + [S]</td>
<td>[Alt] + [S]</td>
</tr>
<tr>
<td>Show Event Init Order</td>
<td>[Alt] + [R]</td>
<td>[Alt] + [R]</td>
</tr>
<tr>
<td>Wire Debugging</td>
<td>[Alt] + [D]</td>
<td>[Alt] + [D]</td>
</tr>
</tbody>
</table>
### Structure/Panel

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Searchbox</td>
<td>[Enter]</td>
<td>[Enter]</td>
</tr>
<tr>
<td>Cut</td>
<td>[Cmd] + [X]</td>
<td>[Ctrl] + [X]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Cmd] + [C]</td>
<td>[Ctrl] + [C]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Cmd] + [V]</td>
<td>[Ctrl] + [V]</td>
</tr>
<tr>
<td>Duplicate</td>
<td>[Cmd] + [D]</td>
<td>[Ctrl] + [D]</td>
</tr>
<tr>
<td>Delete</td>
<td>[Backspace]</td>
<td>[Backspace]</td>
</tr>
<tr>
<td>Select All</td>
<td>[Cmd] + [A]</td>
<td>[Ctrl] + [A]</td>
</tr>
<tr>
<td>Undo</td>
<td>[Cmd] + [Z]</td>
<td>[Ctrl] + [Z]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Cmd] + [Y]</td>
<td>[Ctrl] + [Y]</td>
</tr>
<tr>
<td>Lock/Unlock Panel</td>
<td>[Cmd] + [E]</td>
<td>[Ctrl] + [E]</td>
</tr>
<tr>
<td>Move Panel Module by 1 Pixel</td>
<td>[Cmd] + [Shift] + [Arrow Key]</td>
<td>[Ctrl] + [Shift] + [Arrow Key]</td>
</tr>
<tr>
<td>Move Panel Module by 40 Pixels</td>
<td>[Shift] + [Arrow Key]</td>
<td>[Shift] + [Arrow Key]</td>
</tr>
<tr>
<td>Control Finetuning</td>
<td>[Shift] + Drag with Mouse</td>
<td>[Shift] + Drag with Mouse</td>
</tr>
</tbody>
</table>

You can also duplicate Modules and Macros by holding [Alt] as you drag with the mouse.

### Advanced View Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut (Mac OSX)</th>
<th>Shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Focus to Next Pane</td>
<td>[Tab]</td>
<td>[Tab]</td>
</tr>
<tr>
<td>Move Focus to Previous Pane</td>
<td>[Shift] + [Tab]</td>
<td>[Shift] + [Tab]</td>
</tr>
<tr>
<td>Pan in Structure View</td>
<td>[Alt] + Drag Background with Mouse</td>
<td>[Alt] + Drag Background with Mouse</td>
</tr>
<tr>
<td>Open Macro Structure in Other Pane</td>
<td>[Alt] + Double-click</td>
<td>[Alt] + Double-click</td>
</tr>
<tr>
<td>Function</td>
<td>Shortcut (Mac OSX)</td>
<td>Shortcut (Windows)</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Navigate Through Breadcrumbs</td>
<td>[Alt] + [Left Arrow] and [Alt] + [Right Arrow]</td>
<td>[Alt] + [Left Arrow] and [Alt] + [Right Arrow]</td>
</tr>
<tr>
<td>Toggle Between Horizontal and Vertical Screen Split</td>
<td>[Ctrl] + [H]</td>
<td>[Ctrl] + [H]</td>
</tr>
</tbody>
</table>
Index

A

Akkord [88]
audio
playback [53]
record [54]
automation [35]

B

banks [48]
creating and editing [50]
bookmark [107]
breadcrumb [107]
browser [63]
library [65]
player [64]
building [99]
documentation [113]
navigation [100]

C

Carbon 2 [109]
Connection Manager [23]
connections [111]
core [114]

   CCCCC (Compiled Core Cell Code Cache) [67]

CPU (Central Processing Unit) [62]

D
default value [51]

E
edit mode [13]

H

Heavyocity [64]

I

instruments
connecting [111]
loading [109]

J

Junatik [100]
K
- Keyboard Shortcuts [115]
- KOMPLET Kontrol [67]

M
- macro [101]
- MASCHINE [67]
- Memory Drum 2 [68]
- MIDI & OSC Learn [22]
- MIDI (Musical Instrument Digital Interface) [15]
  - MIDI in [33]
  - MIDI out [33]
  - Properties [28]
- module [101]
- Monark [35]

O
- OSC (Open Sound Control) [15]
  - learn [22]
  - Properties [28]
  - setting up [16]
- OSC Settings [16]
  - Receive [18]
  - Send [20]
  - Sync [21]

P
- panel
  - automatic layout [90]
  - layout [88]
- panelsets [92]
  - creating and editing [96]
  - recall [92]
- play mode [13]
- player and recorder [53]
  - file player [53]
  - file recorder [54]
  - recorder settings [56]
- Preferences [58]
  - CPU Usage [61]
  - Directories [62]
  - General [58]
- Properties
  - Connect [26] [32]

R
- Recorder Settings [56]
S

sample
  external sample editor [66] [87]
  importing [72] [79]
  location [75]
  loop points [83]
  mapping [72] [78]
  sample map [68]

sample map [69]
  embedding [74]
  importing and exporting [69]
  sample map editor [68]

sample map editor
  note actions [84]
  sample list [70]
  settings [86]
  waveform [82]

Shortcuts [115]

snapshot [39]
  bank [48]
  comparing [43]
  default values [51]
  deleting [42]
  master [40]
  Morph + Random [46]
  renaming [43]
  sorting [45]
  storing [42]

split screen [103]

structure view [100]

T

The Finger [35]

Twisted Tools [64]

V

Vectory [92]